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User Guide - Community Links Portal 

Welcome to the Community Links Portal  

The Community Links Portal (CLP) is a secure web portal that provides an Electronic Health Record (EHR) 

about some of your patients: elders who receive Home- and Community-Based Services and Care 

Management from an Aging Services Access Point (an ASAP), under the auspices of the Executive Office of 

Elder Affairs (www.mass.gov/elders). 

An Electronic Health Record (EHR) about your patient, an ASAP Consumer 

from the Registered Nurse who determines clinical eligibility and 
the Case Manager who authorizes Home & Community-Based 
Services 

> A read-only EHR or 
Electronic Health Record 

> Based on Assessments at 
Home Visits at least once 
every six months. 

 

 
 

 Emergency contacts, Advanced Directives 

 Service Plan for Home- & Community-Based Services 

 Key details from the most recent assessment (performed at six 
month intervals, or more frequently as needed) 

o Assessment Narrative: Care Manager or RN's summary 
of the onsite assessment 

o Pain & Falls 
o Medications (self-reported performance, difficulty, list) 
o Mood & Behavior 
o Home Environment 
o Informal Supports: caregiver 
o IADLs - Instrumental Activities of Daily Living 
o ADLs - Activities of Daily Living 

 Care Manager's or RN's direct communication to CLP users 

Quick Start 

Login here https://communitylinks.harmonyis.net/ma  

My User ID 
                                                          

  <my email address>  

First Login See Credentials Email (p. 4) and First Time Login (p. 4)  

My Web Custodian  
 
The Web Custodian is the local coordinator for Community Links Portal, who manages User Accounts for 
individuals who need access.  

For More  
Information 

http://community-links.800ageinfo.com  

 

 

http://www.mass.gov/elders
https://communitylinks.harmonyis.net/ma
http://community-links.800ageinfo.com/
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About This User Guide 
This User Guide is aimed to provide a User at a Health Care Organization (HCO) with a quick overview of the 

Community Links Portal, and is divided into following sections: 

(1) Quick Start 

(2) User Account & First-time Login 

(3) Using the Community Links Portal, focus on Screens & navigation 

(4) Understanding the information about your patient, an ASAP consumer 

User Accounts & First Login  

Technical Requirements  

To ensure an optimal experience with Community Links Portal, be sure to use one of the supported web 

browsers: 

• Internet Explorer, version 9+ • Firefox version 10+ 
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• Chrome version 14+  

• Safari for windows version 5.1+ 

• Safari for Max OSx version 5.1+ 

Accessibility 

In its application design, Harmony has made every effort to make the information available in CLP to be 

accessible to its users with visual impairments or who use assistive technologies.  

Increase/ Decrease Font Size 

Use your web browsers controls to adjust the web page's font size.   

Text Zoom  

Most browsers support the method to adjust font-size by holding down the [ctrl] key while pressing [+] (the 

plus sign) to enlarge, or holding down [ctrl] while pressing [-] (the minus sign) to shrink the text. 

If you use a mouse with a scroll-wheel, you can zoom the text larger or smaller by holding down [ctrl] and 

scrolling the wheel. 

Your browser will remember your setting when you return. 

Internet Explorer 

Here are additional text-sizing controls used Microsoft Internet Explorer. 

Internet Explorer's View > Zoom 
menu

 
Figure 1: screenshot showing text zoom control 

Internet Explorer's View > Text 
Size menu

 
Figure 2: screenshot showing text size control 

On the lower-right corner of 
Internet Explorer's application 

window.

 
Figure 3: screenshot showing Change Zoom Level 

control 

  

Google Chrome 

Chrome's Customization & Control menu is accessible from a button on the top-right of the browser 

window. 
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Figure 4: screenshot Google Chrome Customization & Controls menu 

Chrome's Customization & Controls menu is found 
on the top-right of the application window. 
 
Click on the square icon with three vertical stripes. 

 

 

Skins: Alternative color schemes for light sensitivity 

The Community Links Portal allows the user to set a color-scheme preference for accommodation of visual 

disability or fatigue.  

Black & White: High contrast, 
high brightness 

 
Figure 5: screenshot Black & White skin 

Sunny: the default view is 
medium brightness, medium 
contrast

 
Figure 6: screenshot Sunny skin 

Dark: High contrast, low 
brightness for light sensitvity 

 
Figure 7: screenshot Dark skin 

Well-structured content 

The content of the Community Links Portal uses well-structured semantic markup (headlines, lists, etc.) so 

that users of screen-readers may access all available information. 

Get a User Account 

Your User Account will be issued by the Web Custodian, an individual on staff at your organization.  

The Web Custodian administers CLP User Accounts to individuals, and makes sure that appropriate 

administrative process and security is in place for access to the Protected Health Information (PHI) visible in 

the Community Links Portal. If you will be a Web Custodian and are establishing access to CLP for the first 

time, your User Account will be created by staff at your partner ASAP. 

You will need to provide a unique email address to your Web Custodian. 

Credentials Email  

When your User Account is created, a Credentials email is sent to the email address you've provided. This is 

an automated email from the address communitylinks@harmonyis.com with subject line Community Links 

Portal Access.   The Credentials email contains your UserID, a temporary password, and the Community 

Links Portal login URL.  

 

mailto:communitylinks@harmonyis.com
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Figure 8: screenshot of credentials email 

Note: If you do not receive a 
credentials email, check the 
Spam or Junk E-mail folder of 
your email application, or 
contact your local IT Support. 

First Time Login  

Click on the link in the email (http://communitylinks.harmonyis.net/ma) and your internet browser will 

display the login page. 

 
Figure 9: screenshot of login page 

Enter your email address and 
the temporary password from 
the credentials email. 
 

After correctly providing the temporary password, you will be prompted to change your password.  You 

should choose a password that is known only to you and difficult to guess. 

 
 Figure 10: screenshot of Change Password screen 

Note: Passwords must be at 
least 7 characters and must 
contain at least one (1) special 
character, for example: (*, #, &, 
>, <, %, @, etc.). 

Log In to the Community Links Portal 

Bookmark this link to the login page:  http://communitylinks.harmonyis.net/ma. 

http://communitylinks.harmonyis.net/ma
http://communitylinks.harmonyis.net/ma
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Figure 11: screenshot of login page 

Enter your email address and 
the password the password 
you've set. 
 
 
After you've logged in you can 
change your password on the 
My Account page. 
 

Forgot Password - Password Reset 

If you forget your password, you can reset it yourself.  Click the Forgot Password link on the login screen. 

 
Figure 12: screenshot Forgot Password link on login screen 

You'll need to have access to the 
email account associated to the 
User Account. 
 

Step 1: Enter your email address from your user account on the Forgot Password screen, and click [OK]. 

 
Figure 13: screenshot of Forgot Password Screen 

Note: Notify your Web 
Custodian if you have difficulty 
receiving this email. 
 

 

An automated email is generated, with subject Password Reset Request.  It should arrive within 3-5 

minutes. 

Step 2: If you want to continue with this process and reset your password, click the link in the email.  This 

proves you have access to the email account and want to proceed with the password reset. 
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Figure 14: screenshot of the first Password Reset email 

If you click the link to proceed 
with this process, your previous 
password will be deactivated. 
 

 

The system acknowledges your authenticated password reset request, and tells you to expect a second 

email. 

 
Figure 15 screenshot, system acknowledges your password reset request 

Look for an email from 
<communitylinksportal 
@harmonyis.net> in the next 2 
or 3 minutes. 

 

A second automatically generated email arrives, with subject Community Links Portal Access. This email 

contains your temporary password. 

 
Figure 16: screenshot of second email in Forgot Password process 

This is the same email as your 
first-time login credentials 
email. 
 

Step 3: Click the link in the email. Upon connecting to the site, you will be asked to change your password.  

 
Figure 17: screenshot of change password form 

You must provide the 
temporary password from the 
email as the Current password, 
and enter (twice) a new 
password of your choosing. 
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Screens & Navigation in Community Links Portal  

After you login, the Consumer List is displayed. This is your home screen; it displays all of your patients 

(ASAP consumers) who have consented to share their Electronic Health Record (EHR) with your organization.  

For more information about how an individual's record is displayed to you here, see Consumer List (below). 

Your name and organization are displayed on each screen. 

 
Figure 18: screenshot of Consumer List 

Navigation & Functional elements  

Skins:  Black & White, Sunny, Dark 

Skins allow you to select a color preference and change the look and feel of the site.  Click the link to select 

it. All screens will show the "skin" you select, and the system will remember your preference. User with 

brightness sensitivity or who require a high-contrast screen may select their preference. 

"Sunny" is the default yellow/ orange background shown in screenshots in this User Guide.   

 
Figure 19: screenshot Black & White skin 

 
Figure 20: screenshot Sunny skin 

 
Figure 21: screenshot Dark skin 
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My Account (Change Password) 

Account management is limited to password change functionality.  Contact your organization's Web 

Custodian to update your name or phone number, or any other status change to your User Account. 

 
Figure 22: screenshot of My Account screen 

To change your password, you 
must enter your Current 
Password, followed by twice 
entering your new password.   
 
All passwords must match the 
password strength 
requirements: at least at least 7 
characters in length and 
containing at least 1 special 
character(s) (*, #, &, etc.). 
 

Manage Users 

Only Web Custodians see this link. 

A Web Custodian may create new users up to your organization's maximum, set a user account 

active/inactive, set a user as web custodian, change a user's name or phone number, resend credentials 

(password information), and review the latest temporary password sent to a user. 

> For more information on the role of Web Custodian, and expectations for individuals performing this 

function, see the HCO Companion Guide (available on the CLP Resources website). 

 
Figure 23: screenshot of Manage Users screen 

Logout 

Click this link to sign out of Community Links Portal.  For greatest security, also close all browser windows. 

Consumer List (patients with active consent) 

This is the first screen you'll see after you login.  You'll return to this page after you review any Consumer's 

page, or after any functional page such as My Account or Manage Users. 

On the Consumer List, Consumers are listed in alphabetical order by Last-Name, First-Name, and Middle-

initial.  Date of Birth (DOB) is displayed to support identification of a consumer in case of duplicate names. 

http://community-links.800ageinfo.com/implementation-guides.html
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Figure 24: screenshot of Consumer List page 

Who appears on the Consumer List? 

The Consumer List page shows all ASAP consumers who have an active Web Consent to share their 

Electronic Health Record (EHR) with your particular organization, at the time you display the page.  

Web Consent is a managed by Care Managers at the consumer's case-managing ASAP (sometimes known as 

the consumer's "default ASAP"), and reflects that fact that the consumer's primary Care Manager has 

discussed information-sharing with an elder, probably during a home visit, and secured that consumer's 

formal Informed Consent to share information with your organization.   

The Web Consent data element in a SAMS Consumer record names your organization and indicates a start 

date and an end date to the consumer's Informed Consent.  For a consumer to be listed on your Consumer 

List, and thus their EHR to be visible, today's date must be on or after the data element's Web Consent Start 

Date, with End Date blank. 

Where is Mrs. Miller? She used to be on the Consumer List. 

A consumer may have retracted their Web Consent for some reason, which would have the effect of 

removing her/him from your Consumer List.  Or the Care Manager has set Web Consent inactive because 

the consumer's home care program enrollment has terminated.  Termination reasons might include: long-

term entry to a nursing facility; a move out of the ASAP's catchment; death; or other reasons.  A 

hospitalization or other short-term suspension of services would normally not entail a home care program 

termination. 

Finding a specific Consumer  

Since the Consumer List contains all consumers with active Web Consent to your organization, the list could 

contain hundreds of consumers.  Use the following functions to find your consumer, without the need to 

scroll through many screens. 

Find from the keyboard: [ctrl] - F 

Use your browser's Find function to locate a specific consumer. From the keyboard, strike [ctrl]-F to bring up 

a search form:  enter some, or all, of the name of the consumer you seek. 
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Find from the browser's menu 

Most browsers allow you to search the page text from the menu, which causes the system to display a text 

entry field. Enter your consumer's name, or a part of it, and click [Enter].  The browser finds the next 

matching instance on the page below. 

Microsoft Internet Explorer's Find is 
accessed from Edit  > Find on this Page 

 
Figure 25: screenshot of MSIE Find 

Enter text and click [Enter]. 
 

 
 

Google Chrome's Find is available via the 
Customizations menu  

 
Figure 26: screenshot, Google Chrome 

Enter text and click [Enter]. 

 
Figure 27 screenshot -Chrome's Find text box 
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Consumer Detail (patient EHR) 

This is the core of the CLP, and where you see all current & available data about your patient, an ASAP 

Consumer. 

 
Figure 28: screenshot of Consumer Detail (partial) 

Details 

The Primary Care Manager and Default Agency are shown.  The Agency Phone number indicated is that of 

an ASAP's main desk, not the direct line to the Care Manager.   

Service Plan 

This shows the current active Service Plan in effect as of the date of display, for all ASAP authorized services, 

to be delivered by direct-service provider agencies.   

Notes:   

 If the consumer's services have been suspended, due to hospitalization or vacation, CLP does not 

provide an indication.  

 The name of the service provider organization is not shown.  

Assessment 

Assessments are recorded at least every six months after a required Home Visit by the ASAP Care Manager, 

an RN, or both, or more frequently as needed.  Assessment data is recorded in an instrument called CDS-2 

(Comprehensive Data Set).  This Massachusetts-specific instrument includes the MDS-HC v 2.0 (Minimum 

Data Set for Home Care, InterRAI, 1999), as well as Social, Nutrition and Nursing Modules.  The CDS-2 is the 

EOEA-approved Care Management assessment tool and clinical eligibility dataset used by RNs, in addition to 

capturing standardized information about frailty and functional impairment.  Find out more about CDS-2, or 

view the complete assessment forms.  Below we provide an overview of key CDS-2 components.  

Narrative 

This is labelled "Comments" on the Consumer Detail.  The term "Comments" notwithstanding, the 

Assessment Narrative is the overview of an onsite assessment by the Care Manager or RN, or the clinical 

determination from a recent RN onsite assessment.  It is expected to be relevant to the onsite assessment or 

determination, and may include the following depending upon the type of assessment:  

 for initial assessments, age and marital status  living arrangement (alone or with other 

persons, including names) 

httl://community-links.800ageinfo.com/
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 condition of home environment (safety, 

hygiene, etc.) 

 who was present during the visit 

 how Consumer presents (cognitive status, 

hygiene, ambulation, etc.) 

 medical conditions and limitations 

 recent hospitalizations 

 formal supports 

 review of ADLs/ IADLs 

 informal supports 

 current/ revised Plan of Care 

 Consumer satisfaction/ complaints regarding 

services 

 list of documentation reviewed/ completed 

 planned actions as a result of the 

assessment/visit 

 next scheduled visit 

Note  

All of the content of the Assessment Narrative displays to the CLP user.  On occasion, depending upon the 

business practices of the case-managing ASAP, an Assessment Narrative may contain two (2) narratives: the 

most recent assessment at the top and the previous assessment below that.  

Assessment Details 

 Memory Loss Screen 

o an ADRD screening 

 Physical Findings  

o Ht, Wt, BP, etc.  

 Responsibility / Advanced Directives  

o Conservator, Power of Attorney,  

 Pain  

o Frequency, character, 

 Danger of Falls  

 Fall Frequency  

 Self-Reported Medications  

o Performance & Difficulty Managing 

Medications 

o List of Medications  

 Visits in Last 90 Days  

o Hospital, ER  

 Mood & Behavior Patterns  

o Sadness, Persistent Anger. Unrealistic 

Fear  

 Home Environment 

o Living Space Hazards  

 Informal Support Services  

o Primary, 2ndary Helpers  

 IADL (Instrumental Activities of Daily Living)  

o Performance, difficulty, who helps, 

device needed  

o Medication mgmt  

o Telephone use  

o Shopping  

o Transportation use  

o Meal preparation  

o Housework, Ordinary  

o Laundry  

o Housework, Heavy  

o Manage finances  

 ADL (Activity of Daily Living)  

o Performance, difficulty, who helps, 

device needed, type of assistance  

o Mobility in bed  

o Transfer  

o Locomotion in-home  

o Locomotion outside  

o Eating  

o Dressing Upper  

o Dressing Lower  

o Dressing (General)  

o Toilet use  

o Personal Hygiene  

o Bathing  

Communication/ Journal Notes: 

 Home Evaluation (Date)  

 Risk Evaluation (Date)  

o Optional. Care Manager or Registered 

Nurse notes to HCO, if any changes to 

Home or to Risks since Assessment Date 

 

.
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Schematic of Consumer Detail information 

 
Figure 29: Consumer Detail Schematic - Demographics 

Category: Demographics  
 
 

 
Figure 30: Consumer Detail Schematic - Assessment Comments/ Narrative 

Category: Assessment 
 
 

 
Figure 31: Consumer Detail Schematic - Assessment Memory Loss plus 

Category: Assessment 
 
 

 
Figure 32: Consumer Detail Schematic - Assessment Medications 

Category: Assessment 
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Figure 33: Consumer Detail Schematic - Assessment Mood plus 

Category: Assessment 
 
 

 
Figure 34: Consumer Detail Schematic - Assessment IADLs 

Category: Assessment 
 
 

 
Figure 35: Consumer Detail Schematic - Assessment ADLs 

Category: Assessment 
 
 

 

 
Figure 36: Consumer Detail Schematic - Risk & Home Evaluations 

Category: Home & Risk Evaluations  
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Utilities 

Your browser's standard functions can be used with CLP. 

Printouts 

CLP pages can be printed, just as any standard web page.  Use File > Print or [ctrl]-P to bring up the standard 

printer dialog box, enabling you to send the current page to the printer.  

Bookmarks 

Any CLP page has a permanent URL (web address), which means it may be bookmarked, enabling you to 

return to this page easily. If you use a bookmark to return to the Consumer List or any other CLP page, you 

will be asked to login with password.   

You can share a link or a bookmark any CLP page with your colleague:  when they click the link, they will 

need to provide their userid & password.   

Understanding Consumer/ Patient information in CLP 

When what you see is not what you expect 

Understanding discrepancies between "Consumer" and your patient 

It's important to remember that the Electronic Health Record (EHR) displayed in the CLP is an artifact of your 

patient's Home- & Community-Based Services.  By its nature, assessment information is primarily collected 

on a semi-annual basis or as needed, as required by guidelines for home care program Home Visits and 

requirements for clinical eligibility determination.  The Consumer Detail screen prominently indicates the 

Assessment Date.  If your perspective is that of a Primary- or Acute-Care environment, the timeliness of 

particular elements in the ASAP consumer's EHR may often seem to be at odds with what you know of your 

Patient's recent clinical experiences.   

 A case in point is the CDS data element Visits in the Last 90 Days.  For any consumer record, the Care 

Manager or RN recorded this fact at the time of the assessment. 

 Similarly, the Medication List may seem out-of-date given changes coordinated by your office in the 

more recent past, after the most recent assessment. 

My patient is not visible in the portal, but is known to be a home care 
Consumer 

A consumer must have an active "Web Consent" data element in effect at the time you display the 

Consumer List.  Your patient may not have consented to share their Electronic Health Record (EHR) with 

your organization; or consent may have granted but not yet recorded in the specific CLP data element; or 

may have retracted their consent.  

In addition, your patient may have terminated home care services for some reason. 

The Consumer's record has incomplete information (missing data)  

Your patient is present in the Consumer List, but there is key information missing from their Consumer 

Detail screen.  This situation may result if key Consumer data elements do not align correctly. Here is how it 

works: 



User Guide to CLP  April 8, 2014 
 

File: S:\SIMS\Project Management\PPP - Physician Portal Pilot\Communications & Guides\User Guides, etc\HCO - User Guide\User Guide - HCO - v16 - to post 5-6-2014.docx  Page 17 of 19 

 

Category Includes elements such as: Displays if: 

Demographics Name, Address, DOB, Default 
Agency, Primary Care 
Manager 

A consumer's Web Consent is active for your particular 
organization.  This data element is expected to match the 
consumer's Informed Consent as recorded by a Care Manager. 
 
The Default Agency is a key element governing display of CLP 
information.  You can think of the "Default Agency" as the case-
managing ASAP: the Default Agency data element is expected to 
align to the ASAP overseeing home care program services.   

Service Plan Service Schedule There is at least one (1) active Service Plan at time of display, 
where the Service Plan Agency matches the Consumer's Default 
Agency. 

Assessment Comments (Narrative), core 
consumer facts from Memory 
Loss Screen down to 
Activities of Daily Living. 

There is at least one (1) CDS-2 variation (CM, RN, FULL) where 
the Assessment Agency matches the Consumer's Default 
Agency.  There are occasional scenarios where these elements 
do not match, or certain information has changed. 

Risk, Home 
Evaluations 

Paragraph text written by a 
Care Manager  

These evaluations display only if they exist in the specific format 
created to communicate directly with the COP user.  This 
information, as recorded at time of assessment, is embedded 
directly in the assessment narrative.  These evaluations appear if 
there is a known change to consumer's risks or to the home 
environment, since the last assessment. 
 
Additionally, an empty Risk or Home Evaluation may display, if 
the Care Manager wishes not to display an outmoded evaluation 
after once having written one.  For example, if such an 
evaluation is superseded by the Assessment Narrative of a 
subsequent CDS-2. 

 

Most recent assessment is more than 6 months old 

This may indicate that a Consumer's six-month semi-annual assessment was not completed on schedule for 

some reason.  For example, if the Consumer was hospitalized, or otherwise on suspension, the Assessment 

date may be older than six months. 

Contacting the consumer's ASAP with a question about a consumer. 

The protocols for CLP-related communication with a Care Manager or RN about a specific consumer will vary 

agency by agency.   

For more information, see your Web Custodian or ASAP point person. 

Which ASAP provides home care for my patient? 

For the Home Care program, a consumer is assigned to an ASAP based on their home address: each ASAP 

has a distinct catchment area.  However, a consumer may have received services from another ASAP in the 

past or through some other program:  for example if they have spent time in a nursing facility or have 

moved from town to town. For a tool to look up the ASAP administering home care in a particular 

Massachusetts town, see 800ageinfo.com (direct link: https://contactus.800ageinfo.com/FindAgency.aspx)  

https://contactus.800ageinfo.com/FindAgency.aspx
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For More information about Community Links Portal  

Your Web Custodian 

Web Custodians are primarily responsible for coordinating User Accounts for staff at your organization, and 

for basic support such as first login and password resets.  They will also be familiar with the fundamentals 

described in this User Guide and other useful resources.   

Contact your Web Custodian first if you have any questions about Community Links Portal:  user accounts, 

passwords, how-to, etc. 

Your organization has flexibility to decide how to organize its Web Custodians:  organization-wide, by 

location, or department. 

Blog 

The Community Links Portal Resources blog contains valuable information for Users & Web Custodians 

about use, operation, best practices, and understanding of the Community Links Portal. 

 

http://community-links.800ageinfo.com  
 

Blog content to look for:  

 The most up-to-date edition of this User Guide 

 Glossary of terms 

 Implementation Guide for Health Care 

Organizations 

 Training Materials, such as a sample website, 

annotated screenshots, and more. 

 Reference materials 

 Announcements   

About the Massachusetts Home Care Program 

The Executive Office of Elder Affairs’ home care programs are delivered through contracts with 27 private 

non-profit corporations called Aging Services Access Points (ASAPs).   

Programs 

The Home Care Program provides services to eligible elders to support their needs in the areas of Activities 

of Daily Living (ADLs), and Instrumental Activities of Daily Living (IADLs), as well as social contact and 

support, enabling them to remain at home.   

In addition, Non-MassHealth Standard consumers who have been determined clinically eligible for a nursing 

facility by an ASAP RN may receive, through the Enhanced Community Options Program (ECOP), an 

expanded level of service intended to prevent or delay nursing facility placement.   Those Home Care 

consumers who are determined clinically eligible for a nursing facility by an ASAP RN may receive an 

expanded level of services through a Waiver Program (Community Choices or Home Care Basic Waiver) 

once determined financially eligible for MassHealth Standard by the MassHealth Enrollment Center.  

http://community-links.800ageinfo.com/
http://community-links.800ageinfo.com/
http://community-links.800ageinfo.com/user-guide.html
http://community-links.800ageinfo.com/glossary.html
http://community-links.800ageinfo.com/sample/login-logout.htm
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Care Management  

An ASAP Care Manager in collaboration with the ASAP RN/Home Care Interdisciplinary Team 

 Authorizes & coordinates services provided by third-party direct-service provider agencies 

 Ensures interdisciplinary review of client needs & service planning 

 Reassesses the client’s status at mandated intervals, and after a significant change 

 Responds to client and/or caregiver concerns as they arise  

 Facilitates access to information & referral as appropriate 

Direct Services from sub-contracted provider agencies, not by ASAPs 

Eligible elders may receive a wide array of services, depending on their assessed needs and available 

informal and caregiver supports.   

Specific in-home and community support services available  from sub-contracted providers include  

 Personal Care  

 Homemaking  

 Adult Day Health  

 Chore  

 Companion  

 Alzheimer’s/Dementia 

Coaching 

 Respite 

 Home Delivered Meals 

 Home Health Services  

 Grocery Shopping  

 Laundry  

 Personal Emergency 

Response System (PERS)  

 Companionship  

 Environmental Accessibility 

Adaptations (ramps, grab-

bars, etc.) 

 Translation  

 Transportation 

 Medication Dispensing 

 Home Delivery of Pre-

Packaged Medications 

Appendix 

Document History  

Document History (to be deleted upon formal release) date Author Changes  

User Guide - HCO - v11.docx April 3, 2014 Jim O First assembly 

User Guide - HCO - v12 increment.docx April 7-2014  Next round of edits, respond to Max, Andyg, fill in minor gaps.  
 
Known issue: on page 7, first password reset email.   User Guide notes the 
wrong email address, the email actually comes from 
noreply@harmonyis.com.  Harmony has submitted ticket 35405 to have 
this corrected and added it as an open item on our product readiness log. 
 
Expanded info in section Understanding Consumer/Patient Information in 
CLP. 

User Guide - HCO - v14 - April 23.docx April 23  Trivial edits 

User Guide - HCO - v16 May 1  Edits after STH, LV review 
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